5.1.1 “Tagged Records Management and Selection” Dialogue box ........................................... 35
5.1.2 Creating a New Tag ............................................................................................................ 36
5.1.3 Selecting an existing tag .................................................................................................. 36
5.4 Retrieving the records that have been tagged .................................................................. 36
5.5 Modifying a Tag .................................................................................................................. 37
5.6 In Tray ............................................................................................................................... 38
5.7 Change Assignee ................................................................................................................ 38
5.7.1 Change Assignee for a single folder .............................................................................. 38
5.7.2 Change Assignee for multiple folders ........................................................................... 41
6 DOCUMENT SAVING AND EDITING .................................................................................... 46
6.1 Profile Screen ..................................................................................................................... 46
6.2 Checking Out a document for editing ............................................................................. 46
6.3 Creating a New Version of a document ........................................................................... 47
6.4 Viewing previous revisions of a document ....................................................................... 50
6.5 Viewing the Audit Log ...................................................................................................... 52
6.6 Attaching a Records Explorer document to an Outlook item .......................................... 54
7 GLOSSARY ............................................................................................................................. 57
8 TROUBLESHOOTING ............................................................................................................ 58
8.1 Left Hand menu .................................................................................................................. 58
8.2 F5 Refresh .......................................................................................................................... 58
8.3 Find Records Dialogue box popping up ........................................................................... 58
8.4 Cannot edit a document ..................................................................................................... 58
8.5 Document will not open when I click Edit ......................................................................... 58
APPENDIX 1 – CREATING NEW DOCUMENTS: “CHOOSE FROM OFFICE TEMPLATES” NAVIGATION ... 59
APPENDIX 2 - MAPPING AN OUTLOOK FOLDER TO A RECORDS EXPLORER FOLDER ............... 60
1 ACCESSING THE APPLICATION

Open My Computer. Records Explorer will display under Other drives.

A desktop shortcut can be created by highlighting the program name and dragging it onto the desktop.

Double Click on Records Explorer.

You will be given the following options in the right hand screen:

Double Click on USYD_TRIM_Production to enter the live dataset.

You are now in Records Explorer.
2 DISPLAY

Records Explorer is an interface for TRIM, the University of Sydney’s enterprise record keeping system. Records Explorer mimics the look and functionality of Windows Explorer, whilst interacting with TRIM.

2.1 FOLDERS VIEW

When you launch My Computer, if the left menu is not displayed automatically, click Folders in the menu bar:

![My Computer screenshot]

You will now have a list menu in the left pane:

![My Computer screenshot with expanded menu]

Records Explorer Manual, May 2010
When conducting searches or navigating to folders in Records Explorer options in the left hand pane can be expanded or collapsed. The core menu items are always visible if you scroll up and down whilst the right hand side will only display your search results, the contents of folders etc.

### 2.2 NAVIGATION AND SEARCH OPTIONS

When you have opened the database two search buttons will display in the menu bar, and a set of navigation options will display in the right and left hand sides.
2.3 DETAILS VIEW

As in Windows Explorer you can display the folders in Thumbnails, Tile, Icons, List, or Detail.

**Records Management Services recommends that you use Details display.** The Details display places the information in the right hand pane into columns allowing more information about the records to be immediately apparent, and columns can be sorted into ascending / descending order by Name, Assignee, Type etc.

In the example below the search results are sorted by **Type**:

If you have never used Records Online or TRIM Desktop the majority of these options will be empty when you first log on. They can be customised by you as you begin using the system. The names of any paper files that you have in your possession will appear in the **In Tray** and
some Shared Searches may have been created on your behalf by Records Management Services.

2.4 HIGHLIGHTING MULTIPLE ITEMS IN RECORDS EXPLORER

Some functions outlined in this guide require you to highlight multiple records. You can do this the same way as in Windows Explorer:

2.4.1 ADJACENT RECORDS

Locate the required list of documents (see Section 3: Searching or Section 5: Navigation)

Click on the first document that you require. Hold down the Shift key and click on the bottom document that you require.

You can now click over the highlighted documents holding down the left mouse button to drag the items. Or right click over the highlighted documents to perform functions such as Tagging the records (see Section 5)

2.4.2 NON-ADJACENT RECORDS

Click on the one of the documents that you require. Hold down the CTRL key and click on the other documents that you require one-by-one.
You can now click over a highlighted document holding down the left mouse button to drag the items, or right click over the highlighted documents to perform functions such as Tagging the records (see Section 5)
3 SEARCHING

3.1 INITIATING A NEW SEARCH USING THE “RESET TRIM SEARCH” BUTTON

The Reset TRIM Search button in the menu bar will always result in a clean search being initiated (i.e. it will not inherit any filters set during a previous search):

Click the Reset TRIM Search button. The Find Records dialogue box will then pop up:
3.2 SEARCH TAB

The Search tab allows you to select the type of search method that you wish to use and to enter the relevant text. Common search methods include Title Word, Record Number, Creator, and Date Created.

Click the yellow folder to the extreme right of the Search By field:

A dialogue box called Search Methods will pop up. The search methods can be displayed in categories or as a single list:

If using the categorised display, expand each option using the +

Select the desired search method. Click OK.

This will return you to the Find Records screen. Enter the text you wish to search for in the Equal To field:
Click **OK**

**NB - If the Equal To field is left blank you cannot run a search – even if you have used the Filter tab to set parameters for your search.**

After you have used a search method once it will then display in the drop down list in the **Search By** field (to the left of the yellow folder icon).

### 3.3 BOOLEAN SEARCHING

Multiple search terms can be set by selecting **New** and then adding an additional search type. Boolean searches work on the **And, OR, Not** principle. E.g. Creator “Bloggs, Joe”, and Title Word “Madsen” etc.
3.4 SORT TAB

Currently the **Sort** tab does not affect the search results. Do not use the sorting facility here – run the search, and sort the results via the column headings.

3.5 FILTER TAB

The **Filter** tab allows you to refine your search to only return results of a certain Record Type, Status or Disposition.

Under the **Record Type** section, right click and select **Untag All**:
Then individually tag the record types that you do wish to search on by clicking in the white space to the left of the record type name – e.g. Electronic Folder, Document, User Subfolder – as shown below a tick will be placed next to the selected record type:

If you have not populated the **Search** tab please ensure that you do so before clicking **OK**.

If you wish to search for records that are Inactive, Destroyed or Archived uncheck the **Active** checkbox under **Disposition**:

Likewise, if you would like to ensure that your search results are confined to records that are active and usable make sure that **Active** is checked and uncheck all other options available under the **Disposition** section.

If you have not populated the **Search** tab please ensure that you do so before clicking **OK**.
For document searches, you can filter your results to return only documents that have been **Declared As Final** or alternatively, **Not Declared As Final**. The default is to search for both, as many users do not finalise documents in a consistent manner. (Finalising a document means that the document cannot be edited.)

### 3.6 MODIFYING A SEARCH USING “TRIM SEARCH” BUTTON

If you have made a typo or want to change one of the search parameters you set, you can select TRIM Search from the top menu bar – this will retain all of the criteria that you set for the previous search – including Boolean search terms and filters - so that you only have to edit fields rather than start from scratch.

### 3.7 SEARCH RESULTS DISPLAY

The search results will display in the right hand side of the screen.
You may notice your Favourite Searches option in the left hand pane expands. If you close the Favourite Searches using the + your search results will disappear. It is best to leave the Favourite Searches option expanded.

To view the contents of a folder double click on the folder name. The Subfolders or Documents will be displayed in the right hand pane. When you open a folder from your search results it will then list under the New Search button in Favourite Searches on the left, whilst the folder contents are displayed on the right.
3.8 SEARCH PROGRESS AND COUNT

Search results do not display until all of the relevant records have been retrieved. While the search is in progress you can see the result count accumulating in the bottom left of the screen.

A final count of the number of records retrieved will then display:

3.9 NO SEARCH RESULTS

If there are no search results the following message will be displayed in the right pane.

Use the TRIM Search button (See Section 3.2) to modify the search criteria.

3.10 PERSONAL SEARCHES / FAVOURITES SEARCHES

After running a search you are able to then save that search criteria under Personal Searches or Favourite Searches. Saving a search allows you to re-run a complex search at a later date without having to recreate all of the relevant criteria. Personal and Favourite Searches are personal - they can only be viewed by you.
After performing a search, expand the menu item **Personal Searches** to display its contents. Right click over **New Search** and select **Save my Last Search**, as below:

The **New Saved Search** dialogue box will appear:

Under **Name** type a title for your search so that you will recognise it later. Records Management Services recommends that you include an agreed **acronym** for your department as a prefix for the saved search name.
Do not modify the Description field – this contains a summary of the search criteria that you are saving. The search criteria is also present under the Search, Sort and Filter tabs, if you wished to review it before saving.

(If you wish to save this under Favourite Searches select the check box Add this Saved Search to your Favourites Tray.)

Click OK.

The search will now be displayed under Personal Searches:

If you wish to modify the search criteria at a later date, right click on the search name and select Edit this Search:

This will open up a dialogue box similar to the New Saved Search screen where you can use the Search, Filter and Access Controls tabs to modify the search criteria.

To run a saved search, click on the search name. The Find Records dialogue box will pop up. Click ok without making any modifications. Sometimes if you re-run the same saved search
in one session it will bypass the Find Records dialogue box and will simply display the search results in the left pane underneath the Search name.

3.11 “NEW SEARCH” IN PERSONAL SEARCHES/FAVOURITE SEARCHES

By expanding Favourite Searches or Personal Searches in the left hand list options you will find that there is a New Search button. This is the same as the TRIM Search button i.e. it will inherit all the values of your most recent search including any filters that you set. Records Management Services suggests you use the two search options in the menu bar instead of this feature.

3.12 SHARED SEARCHES

A Shared Search is a saved search that has been opened up for other people to view. You can share it with one other person, a whole department or any combination of people/departments provided they are registered Records Online user.

The search criteria will be the same for everyone – however, the results may vary from person to person depending on their access rights. Please bear this in mind if you are unable to view files that one of your colleagues can see. If you think that you should be able to view a file and you cannot, please notify Records Online to review your access rights.

To create a Shared Search run the search and follow the same steps as outlined in Personal Searches. Then email records.online@sydney.edu.au with the exact name of the saved search and the names of the users requiring access to the saved search, the Helpdesk will update the access controls and send you through an email notification to let you know the shared search is now available. Please then communicate this to the rest of the users in the access group.
4 CREATION

4.1 ELECTRONIC FOLDERS

The first level in the folder structure is the Electronic Folder. To create a new Electronic Folder right click over the New Search or Favourite Searches menu item in the left pane.

Select New TRIM Record

The following options will be displayed. Select Electronic Folder. Click OK.
A new record entry form will appear:

<table>
<thead>
<tr>
<th>Data Entry Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title (Free Text Part)</td>
<td>The portion of the title that will display in your search results.</td>
</tr>
<tr>
<td>Classification</td>
<td>The portion of the title that summarises the business process being covered by the documents inside. It will not display as part of the title, though often Access control and Retention are linked the classification so it is important they are included</td>
</tr>
<tr>
<td>Owner Location</td>
<td>Upon changing the Assignee this will be populated automatically, this should be the name of the Assignee’s department</td>
</tr>
<tr>
<td>Assignee</td>
<td>The name of the person in charge of the matter that the folder pertains to</td>
</tr>
<tr>
<td>Retention Schedule</td>
<td>NSW Government code that helps RMS determine how long to keep the documents for</td>
</tr>
<tr>
<td>Initiate Workflow From</td>
<td>This feature is not presently functional</td>
</tr>
</tbody>
</table>

4.1.1 MODIFYING ACCESS CONTROLS

It is recommended that Access Controls are added to the Electronic Folder so that the folder can only be viewed by relevant personnel. Only users within the Access Group will be able to see the folder and its contents. All subfolders and documents within the Electronic Folder will inherit these Access Controls.

After completing the details in the General tab, click the Access tab.
Records Explorer will run a spell check on the free text title at this point. Click OK or change spelling as needed.

In the Access Controls pane at the bottom highlight View Metadata, and then click Custom in the bottom right:

![Image of Access Controls](image)

In the Customise Access – View Metadata dialogue box select Restricted to the following Locations (and any of their members). Highlight your own name in the Sort Name field and select Remove.
Then select **Add**. A list of all locations will appear:

Simply start typing the name of the business unit, or individual’s surname, the **Prefix Search – Name** dialogue box will appear with your text inserted, place an asterix (*) at the end of the word and hit **Enter**.
All locations that begin with that word will appear in a list. Select the relevant location and click OK.

This will return you to the Customise Access – View Metadata dialogue box. Repeat this step if you require more users or business units to have access. Click OK.

You are now back in the New Electronic Folder dialogue box. Click OK.

Upon creation a dialogue box will pop up with:
Selecting Yes will then expand the Recent Containers menu item in the left pane and the new folder will be listed alphabetically. It will be highlighted in light grey.

You can then double click on the folder to open it and begin adding documents (see Sections 4.3 – 4.6), or to add Subfolders (see Section 4.2). If you need the Records Helpdesk to populate the Subfolders and User Subfolders for you, continue creating all of the Electronic Folders you need then send an email to records.online@sydney.edu.au asking for the subfolders to be populated for all Electronic Folders created by yourself and the date of creation.

4.2 ELECTRONIC SUBFOLDERS AND USER SUBFOLDERS
To create a **Subfolder** within an existing Electronic Folder, open the existing folder, or highlight it, and right click > **New TRIM Record**.

The following options will be displayed:

Select **Subfolder**. Click **Ok**.
Follow the steps for creation as per creating an Electronic Folder. You will notice that the fields are different. Some fields are inherited directly from the parent container – i.e. the Electronic Folder – and cannot be modified.

You can add a different **Retention Schedule** for this folder. Subfolders may need to be kept for different lengths of time. Refer to the folder structure outlined by Records Management Services and your department.

### 4.3 CREATING A NEW BLANK DOCUMENT

Locate the Folder / Subfolder where you wish to save a new document.

Right Click > **Create New Document** > (Select appropriate document type)
(If you select **Choose from Office Templates...** a dialogue box will appear which will allow you to navigate to a saved Template on your network drive, or to another Microsoft Office application. See **Appendix 1** for more detail)

The **New Record Document** dialogue box will appear:

Enter a document title, following naming conventions outlined by your department.

Click **OK**. Records Explorer will then run a spell check. Click **OK** or change spelling as needed.
Then you will receive the following message:

Click **Yes** to launch the blank document/template and begin editing. If you select **No** and wish to work on the document later, it can be found in the appropriate folder or under **Recent Records**.

### 4.4 UPLOADING AN EXISTING DOCUMENT USING THE DOS PATH

You can upload an existing document by selecting **New TRIM Record > Document** and using the “DOS” path to locate the document in your network drives.
4.5 DRAG AND DROP DOCUMENT SAVING

4.5.1 DRAG AND DROP A SINGLE DOCUMENT

Locate the required document in your network drive, click on it holding down the left mouse button and then drag it over into the appropriate folder in Records Explorer.

You may wish to have Records Explorer open in a separate window from your network drive if you find that more convenient, though you can use a single screen as long as you have the folder that you are dragging into open in the left pane.

When you release the mouse the following screen will appear:

Click in the check boxes to select the desired functions. The Drag and Drop Options are defined in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create HP TRIM TR5 Reference in Source File Folder</td>
<td>Saves the document to Records Explorer, and leaves a link to the document in the source directory.</td>
</tr>
<tr>
<td>Carry forward Record Type, Container, User Fields and Selected TRIM Fields</td>
<td>Useful for dragging multiple documents. The Record Type, Container, Author and relevant dates for all documents in that drag and drop will be copied over. <strong>Always leave this option checked.</strong></td>
</tr>
<tr>
<td>Attempt to store all files after first one without user interaction</td>
<td>Again, when dragging multiple documents, only one New Record Document form will need to be completed, all other documents will not require spell check etc. Used in conjunction with the option above.</td>
</tr>
</tbody>
</table>
Delete Original Files after saving to HP TRIM

Original documents from your network drives will be automatically deleted after saving them to Records Explorer.

Resequence Titles after Save

If you drag over a batch of documents that bear some relation to each other and you would like them to be considered as a “batch” you can then add a suffix to the document title such as “1 of 10, 2 of 10…. 10 of 10” to represent this relationship.

An additional dialogue box will appear:

Select from the Title Formats at the bottom how you would like the numbers to display. Select Apply.

Click Yes to the following warning:

Click Save.

A New Record Document form will appear, with the title inherited from the title in your network drive and the Container populated with the record number of the folder that you dragged the document into:
Click OK.

4.5.2 DRAG AND DROP MULTIPLE DOCUMENTS

For multiple documents, ensure that the document titles are spelt correctly and are formatted according to your naming conventions before dragging them from your network drive into Records Explorer.

Highlight the required documents by following the instructions outlined in Section 2.4. Hold down the left mouse button and drag the documents over to the relevant folder in Records Explorer. Release the mouse button.

The Drag and Drop Options dialogue box will pop-up – ensure that you check the option Attempt to store all files after first one without user interaction. This means that only one New Record Document form will need to be filled in, all subsequent documents will be saved using the title they have in the network drive without the need to click ok to the dialogue box. Click Save.

A New Record Document form will appear. Click OK.

A second dialogue box will also be present in the top of the screen called Progress of Bulk Storage Operation. This will show the progress of the documents being saved. It will disappear when all of the documents have been catalogued.
4.6 SAVING OUTLOOK ITEMS

Outlook items can be saved using drag and drop, as per a document from your network drive. They can also be dragged over in bulk by highlighting all relevant emails and dragging into Records Explorer. The **Bulk Email Storage Options** box will pop-up:
Always leave **Carry forward the selected Record Type** checked. You may also wish to check **Only show data entry screen for first item stored** so that you need only perform a spell check on the first item and all subsequent items will be stored without need of your interaction.

Records Explorer also supports mapped folders in your Outlook inbox. This is not advisable for users with subfolders in their folder structure as it would require mapping each subfolder. (See Appendix 2 for mapping an Outlook Folder to a Records Explorer Folder)

Presently Records Explorer cannot support calendar items that are dragged directly from Outlook. If you wish to save these document types please save them to your network drive/desktop in **iCalendar Format** (.ics extension)

Then save it into Records Explorer using Drag and Drop as you would any other document stored in your network drive. This will allow you to open the document and launch it into its original format to see all the contextual information such as attendees.
5 NAVIGATION

5.1 TAGGED RECORDS

Tagging records allows you to group together records that may not otherwise be related. Tagged Records lists are personal and can only be viewed by you.

Run a search for folders or documents that you would like to tag, or perform this task after creating of a new record.

5.1.1 “TAGGED RECORDS MANAGEMENT AND SELECTION” DIALOGUE BOX

Select the records that you want to tag from the search results. (To highlight multiple records follow the instructions in Section 2.4.)

Right Click on the text block and select Tag Selected Records

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>AuthorOfDocProblem.doc</td>
<td>AuthorOfDocProblem</td>
<td>AuthorOfDocProblem</td>
</tr>
<tr>
<td>Client response letter final draft incl sole supplier(Citrix).doc</td>
<td>Client response letter final draft incl sole supplier(Citrix).doc</td>
<td>Client response lett...</td>
</tr>
<tr>
<td>Client response lett...</td>
<td>Client response lett...</td>
<td>Client response lett...</td>
</tr>
<tr>
<td>doc test.doc</td>
<td>doc test.doc</td>
<td>doc test.doc</td>
</tr>
<tr>
<td>Folder structure file naming conventions 191409.doc</td>
<td>Folder structure file naming conventions 191409.doc</td>
<td>Folder structure file...</td>
</tr>
<tr>
<td>Hayley is testing these words.doc</td>
<td>Hayley is testing these words.doc</td>
<td>Hayley is testing the...</td>
</tr>
<tr>
<td>Learning Solution Demo.doc</td>
<td>Learning Solution Demo.doc</td>
<td>Learning Solution Demo...</td>
</tr>
<tr>
<td>Problem with Citrix</td>
<td>Problem with Citrix</td>
<td>Problem with Citrix</td>
</tr>
<tr>
<td>Problem with Citrix</td>
<td>Problem with Citrix</td>
<td>Problem with Citrix</td>
</tr>
<tr>
<td>Procedure - Modern</td>
<td>Procedure - Modern</td>
<td>Procedure - Modern...</td>
</tr>
<tr>
<td>RMS Helpdesk File &amp;...</td>
<td>RMS Helpdesk File &amp;...</td>
<td>RMS Helpdesk File &amp;...</td>
</tr>
<tr>
<td>Seminars Sydney &amp;...</td>
<td>Seminars Sydney &amp;...</td>
<td>Seminars Sydney &amp;...</td>
</tr>
<tr>
<td>Student File Scann...</td>
<td>Student File Scann...</td>
<td>Student File Scann...</td>
</tr>
<tr>
<td>T Drive Issues for...</td>
<td>T Drive Issues for...</td>
<td>T Drive Issues for...</td>
</tr>
<tr>
<td>T Drive Issues for...</td>
<td>T Drive Issues for...</td>
<td>T Drive Issues for...</td>
</tr>
<tr>
<td>Test doc1.doc</td>
<td>Test doc1.doc</td>
<td>Test doc1.doc</td>
</tr>
<tr>
<td>Test doc2.doc</td>
<td>Test doc2.doc</td>
<td>Test doc2.doc</td>
</tr>
<tr>
<td>Test doc3.doc</td>
<td>Test doc3.doc</td>
<td>Test doc3.doc</td>
</tr>
<tr>
<td>Test doc4.doc</td>
<td>Test doc4.doc</td>
<td>Test doc4.doc</td>
</tr>
<tr>
<td>Test doc5.doc</td>
<td>Test doc5.doc</td>
<td>Test doc5.doc</td>
</tr>
<tr>
<td>Test doc6.doc</td>
<td>Test doc6.doc</td>
<td>Test doc6.doc</td>
</tr>
</tbody>
</table>

The Tagged Records Management and Selection dialogue box will pop up:
This will be blank when you first start using Records Explorer. (See Section 5.1.2 for creating a new tag. See Section 5.1.3 for how to select an existing tag.)

5.1.2 CREATING A NEW TAG

To create a new tag, type the name under **New Tag Name** in the bottom of the *Tagged Records Management and Selection* dialogue box and click **Create**. The tag will then be added to the My Record Tags list.

To use the tag, highlight it and click **OK**.

The new tag will now appear under the Tagged Records menu item in the left pane.

5.1.3 SELECTING AN EXISTING TAG

Right click on the record you wish to tag > **Tag Selected Records**. In the Tagged Records Management and Selection dialogue box existing tags will be displayed in the **My Record Tags** pane. Select the relevant tag and click **OK**.

The document will now be included amongst that tag list when you retrieve the tag contents.

5.4 RETRIEVING THE RECORDS THAT HAVE BEEN TAGGED

Expand the Tagged Records option in the left pane list.

Double click on the tag name to open up a list of all of the tagged records in that tag.
5.5 MODIFYING A TAG

Tags can be deleted, but cannot be renamed. Deleting a tag does not affect the records within, they still exist.

To delete a tag, right click on the relevant tag and select **Manage my Tag Groups**: 

![Screenshot of Manage my Tag Groups dialog]

Highlight the required tag and select **Delete**

![Screenshot of Tagged Records Management and Selection dialog]

If you wished to change the name of the tag and retain all the tagged records, first create the new tag name.

Open the existing tag, highlight all the records, right click, Tag Selected Records and select the new tag name.

Delete the old tag.
5.6 IN TRAY

The In Tray is located in the menu options and is populated with folders that have been assigned to you. Double click on the In Tray to view its contents:

Assignee is only set against a top level Electronic Folder. Subfolders and Documents are considered to be “Contained in” the top level folder.

5.7 CHANGE ASSIGNEE

5.7.1 CHANGE ASSIGNEE FOR A SINGLE FOLDER

If a project has been reassigned to another officer, the Assignee can be changed by navigating to the appropriate Electronic Folder and right click > Edit Properties...:
Select the yellow look-up folder to the right of the **Assignee** field:
The **Select From Locations** dialogue box will pop up with the current Assignee listed. Simply begin typing the surname of the new Assignee. The **Prefix Search – Name** dialogue box will appear. Hit **Enter** / click **OK**.

A list of all people with surnames beginning with those letters will appear. Select the appropriate person from the list. Click **OK**.

This will return you to the **Properties** screen. Click **OK**.

The Assignee is now changed. The folder will now appear in the **In Tray** of the new Assignee and will no longer be in the In Tray of the previous Assignee. The folder is still searchable and accessible by all relevant parties.
5.7.2 CHANGE ASSIGNEE FOR MULTIPLE FOLDERS

To change the Assignee for a large number of folders, navigate to the appropriate folders via a search, a tag, your own In Tray etc. Highlight all of the relevant folders by following the instructions in Section 2.4. Right Click > Show in Context:

The Select From Records dialogue box will pop-up listing the selected folders. Right Click > Tag All:

A tick will appear next to all of the Folders. Right Click > Locations > Assignee
The Set Assignee dialogue box will appear. Ensure that All Tagged Rows is selected. Click OK.

In the Set Assignee – All Tagged Rows dialogue box, select the yellow look-up folder to the right of the Set to Location field:
The **Select From Locations** dialogue box will appear. Begin typing the surname of the new Assignee (see **Section 5.7.1** for detail). Click **OK**.

Select the correct user from the resulting list and Click **OK**.

In the **Set Assignee** dialogue box, click **OK**.
Select **Yes To All**:

When the **Set Assignee** dialogue box disappears your list of folders will be displayed and the Assignee will reflect the changes:
Close the dialogue box and return to Records Explorer, which will still be open in your task bar.

The folders will now be reassigned and will now appear in the In Tray of the new assignee.
6 DOCUMENT SAVING AND EDITING

6.1 PROFILE SCREEN

Double clicking on a document opens up the Profile Screen. Select what you want to do with the document:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Opens a Read-Only copy.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens a copy that can be altered. Upon saving and closing the document it will be checked back into Records Explorer as a new revision (see Section 6.4).</td>
</tr>
<tr>
<td>Details</td>
<td>Select to view the metadata of the document (i.e. the Title, Retention Schedule, Assignee etc)</td>
</tr>
<tr>
<td>Properties</td>
<td>Select to see an editable version of the metadata</td>
</tr>
<tr>
<td>Checkin</td>
<td>This option will only be available if the document you have selected is currently checked out to you.</td>
</tr>
<tr>
<td>Finalise</td>
<td>Locks the document so that it becomes Read-Only and can no longer be opened for editing by users. If at a later date a revision needs to be made you can create a new version (see Section 6.3) and make changes to that document, which will be related to the first document as [v1] and [v2] etc.</td>
</tr>
<tr>
<td>Update Typed Title</td>
<td>Allows you to make changes to the document title. Enter the changes to the title and then click the Update Typed Title button.</td>
</tr>
</tbody>
</table>

6.2 CHECKING OUT A DOCUMENT FOR EDITING

To edit a document you must check it out of Records Explorer. When you check it out it will be saved into your My Documents under a folder called “Offline Records” with the same red and blue X that characterises Records Explorer. Upon saving the edited document it will be checked back into Records Explorer as a new revision under the same name, record number etc.
To check out a document double click on the document name. The Profile Screen will appear:

Select the Edit option. The document will launch in its native application.

Edit the document and click Save as normal. Then close the document. The document is now checked in. There can be some delay between closing a document and Records Explorer recognising that the document is checked back in. Before you close your Records Explorer session open the My Checked Out Documents menu item. This should be empty. If not, double click on the document and select the Checkin option from the Profile Screen.

You can hit CTRL+s or save in Word (etc) as many times as you like whilst you are working on the document, a new revision will only be created in Records Explorer once you have closed the document at the end/checked it back in.

When opening Records Explorer for the first time each day you will receive a message if there are any documents Checked Out to you. You will not receive any message if there are no documents Checked Out and you will not receive a message again until you have logged out of your computer and back in again.

6.3 CREATING A NEW VERSION OF A DOCUMENT

Locate the document that you wish to create a new version of.

Right Click on the Document name, select Advanced > Create New Version
The following dialogue box will appear. The greyed out fields will be inherited automatically, you can customise what other aspects of the original record you want the new version to inherit. Records Management Services recommends that you do not change any of the defaults.

If you have already begun drafting the New Version of the document and it is saved in your network drives tick the **Use the following document to start off the new version** check box at the bottom, the field below it will then become active and the document icon at the far right can be clicked to start a Browse.
Locate the document in your drives and click **Open**. Then click **OK** in the original dialogue box.

If you do not have a working draft, skip the above step and simply click **OK**. The New Version will be a direct copy of the original until you open it and make changes.

The two versions will have [v1] and [v2] appended to the title. They will also have the same record number but with [v1] and [v2] appended to the Record Number.

<table>
<thead>
<tr>
<th>Name</th>
<th>Checked Out</th>
<th>Finalised</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>20100301. RMS Project Action Items.xlsx</td>
<td></td>
<td>DOC2010/307</td>
<td></td>
</tr>
<tr>
<td>banner for madsen.doc [v1]</td>
<td></td>
<td>DOC2010/306[v1]</td>
<td></td>
</tr>
<tr>
<td>banner for madsen.doc [v2]</td>
<td></td>
<td>DOC2010/306[v2]</td>
<td></td>
</tr>
</tbody>
</table>

It is best practice to then **Finalise** the original document so that it can no longer be edited. Double Click on the document with [v1] appended to the title. Select **Properties** from the Profile Screen.

Check the box at the bottom of the screen **Declare As Final After Saving**.
Click **OK**

If the new version of the document needs to be placed into a different folder, locate that other folder and drag the document over. The following dialogue box will appear:

Select **Move these Record to the Container**. You will get a confirmation that the move was successful.

### 6.4 VIEWING PREVIOUS REVISIONS OF A DOCUMENT

Each time a document is checked out, changes are made and the document is checked back in, Records Explorer saves a new revision and keeps the old copy in the background. These previous incarnations can be viewed by double clicking on the document and selecting the **Properties** option from the Profile Screen.
Select the **Revisions** tab:

![Properties DOC 2010/307](image)

**NB** - If a document has never been modified the Revisions tab will not exist.

Under the Revisions tab will be a list of all previous revisions of the document, in the example below there has only been one modification. You can use the **Preview** tab at the bottom to see a reduced version of the previous version:
The Preview may not always work, as some document types are not supported by the Document Viewer.

Or double click on the revision path in the top view pane. The following dialogue box will appear:

Select **View**, and the document will launch in its original format.

If the document opens in the **TRIM Document Viewer** open File > **Launch** and it will launch into the native format.

### 6.5 VIEWING THE AUDIT LOG

Each time a person makes a modification on a folder or document this activity is recorded in the **Active Audit Events** against their unikey login.

Locate the document/folder. Right Click > **Show in Context**:
The **Select From Records** dialogue box will display. Right Click > Details > **Active Audit Events**:

![Select From Records Dialogue Box]

The **Active Audit Events** will then display with the activity performed listed under **Event**, the unikey of the person who performed the activity under **Login**, plus the **Event Date** of the activity and some further context listed under the **Event Details**:

![Active Audit Events Display]
6.6 ATTACHING A RECORDS EXPLORER DOCUMENT TO AN OUTLOOK ITEM

This function is only supported for Outlook at the present time, not for other email clients

Locate the document in Records Explorer.

Right click on the document name > Advanced > Send Email via Outlook

The following dialogue box will appear:
Select the **Mail Item Type** you desire – Email, appointment or task – on the left.

On the right are three options for the attachment format:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Attach As TRIM References</strong></td>
<td>Provides the recipient with a link to the document in TRIM Desktop. The recipient will only be able to open the document if they are a registered user with Records Management Services and they have sufficient access rights to view your documents. Sending a link to a colleague allows them to check the document out and edit it, check it back in and all the work automatically captured into TRIM.</td>
</tr>
<tr>
<td><strong>Attach As Real Electronic Document</strong></td>
<td>Provides the recipient with a normal attachment in its native application (e.g Excel or Word). This provides no security measure on who can open the document. If the person makes any revisions to the document they will not be captured into TRIM unless this is conducted manually.</td>
</tr>
<tr>
<td><strong>Use Both Methods</strong></td>
<td>This can provide the recipient with a link to the document in TRIM if editing is required, it can also provided them with a native copy of the document if they need to send it on to a third party or do not wish to make any changes to the document but would still like to know where the document is located in TRIM. This is also useful if you are not sure if multiple recipients are Records Explorer users.</td>
</tr>
</tbody>
</table>

This method cannot be used to attach to a reply. Nor can you drag a document from Records Explorer to Outlook as an attachment. You will need to save a copy to your network drive/desktop by Right Click > Advanced > **Export As**...
You will be given the following options – the default option is to export only the current incarnation of the document:

You can then attach the document to the Reply as you would normally.
## Glossary

<table>
<thead>
<tr>
<th>TERM</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRIM</td>
<td>The program for which Records Explorer is an interface. Also referred to as <strong>HP TRIM</strong> in the Drag and Drop Options.</td>
</tr>
<tr>
<td>Record</td>
<td>Any evidence of a business transaction tacking place – an email, memo, tender, letter, meeting minutes etc.</td>
</tr>
<tr>
<td>Folder</td>
<td>Much the same as a Windows Explorer folder, though with additional metadata. Used in this guide as an abbreviation of the following*:</td>
</tr>
<tr>
<td>*Electronic Folder</td>
<td>Refers to the top level folder in the structure, Electronic Folder is the name used in TRIM. This is where the summary of the project is recorded. Documents should not be added at this level.</td>
</tr>
<tr>
<td>*Subfolder</td>
<td>Second layer of the folder structure; subfolders are contained within an Electronic Folder. Documents can be added at this level if there are no User Subfolders within.</td>
</tr>
<tr>
<td>*User Subfolder</td>
<td>Third layer of the folder structure; Documents should always be added at this level unless no User Subfolders exist. “User Subfolder” is the name used in TRIM, it has a pink icon.</td>
</tr>
<tr>
<td>Document</td>
<td>The form that a record takes – Microsoft Office applications, CAD, Outlook items etc.</td>
</tr>
<tr>
<td>Container</td>
<td>Folder in which a subfolder or document is stored.</td>
</tr>
<tr>
<td>[Yellow] Look-up folder</td>
<td>Contains different features depending on where the look-up is located, click on the look up to make selections.</td>
</tr>
</tbody>
</table>
8 TROUBLESHOOTING

8.1 LEFT HAND MENU

The left hand list pane displays a selection of your search results. Do not be alarmed if this does not refresh at the same speed as the right hand view. Some features in the left hand pane will only refresh after you have closed the application.

8.2 F5 REFRESH

If you are refreshing in order to see “Checked Out” update and it is causing the “Find Records” to pop up, instead wait til later in the session and check under “My Checked Out Documents” instead. If they are still “Checked Out” ensure that all documents are closed and use the Profile Screen (double click) or Right Click > Advanced > Check In.

8.3 FIND RECORDS DIALOGUE BOX POPPING UP

This happens occasionally on an F5 refresh particularly in the Shared/Saved Searches functions. Records Management Services aim to improve this functionality on the next release. Try clicking out of the folder and then back into it again rather than using the F5 button to refresh the screen. This should update the view.

8.4 CANNOT EDIT A DOCUMENT

Is it finalised? If yes, it cannot be edited. You should create a New Version and make changes to that.

8.5 DOCUMENT WILL NOT OPEN WHEN I CLICK EDIT

You can only open a document for edit if you have the application installed on your PC. e.g. if you wish to open a CAD document you must have the compatible software installed on your computer or else you can only see a Read-Only version in the TRIM Document Viewer. You may receive the following message:

![TRIM Context Error Message]

Failed to open 'C:\Documents and Settings\[username]\My Documents\Offline Records (12)\viewer\Drawing LVD3'.
No application is associated with the specified file for this operation. (0x80070483).

It may also try to launch Internet Explorer, to direct you to the software.
APPENDIX 1 – CREATING NEW DOCUMENTS: “CHOOSE FROM OFFICE TEMPLATES” NAVIGATION

When creating a blank document, if you require a document template or an application other than Word, Excel or Powerpoint you can reach it by right click > Create New Document > Choose from Office Templates...

Locate the template on your network drives.

For other Microsoft Office applications navigate to C:\Documents and Settings\All Users\Start Menu\Programs\Microsoft Office:

Please Select a File

Look in: Microsoft Office

File name: [Path]

Files of type: [File Types]
APPENDIX 2 - MAPPING AN OUTLOOK FOLDER TO A RECORDS EXPLORER FOLDER

Create/locate the relevant folder in Records Explorer. Copy the Record Number.

Open Outlook.

Create/locate a folder in your inbox for the relevant matter. Ensure it is highlighted.

Select the TRIM button in your menu bars > Current Folder > Create Link.

A TRIM Folder Properties dialogue box will pop up:

Select Document using the down arrow.

Paste the Record Number in the Container field.
Leaving **Display data entry form when cataloguing messages** ticked will ensure that a spell check is run and that you can double check that the document is being contained in the correct folder. You can uncheck this if you would rather not go through that step.

Click **OK**.

You can now drag emails into that Outlook folder and they will be catalogued into TRIM.